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CHAPTER #2 
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Fy 

CURVED BEAM ANALYSIS 
 
This example, unlike that of the first chapter, will lead you quickly through those aspects 
of creating a finite element Study with which you already have experience.  However, 
where new information or procedures are introduced, additional discussion is included.  
For consistency throughout this text, a common approach is used for the solution of all 
problems.  

 
 

Learning Objectives 
 

In addition to software capabilities studied in the previous chapter, upon completion of 
this example, users should be able to: 
 

 Use SolidWorks Simulation icons in addition to menu selections. 
 

 Apply a split line to divide a selected face into one or more separate faces. 
 

 Simulate pin loading inside a hole (or other loading on a curved surface). 
 

 Use Design Checks to determine the Factor of Safety or lack thereof. 
 

 Determine reaction forces acting on a finite element model. 
 
 

Problem Statement 
 

A dimensioned model of a curved beam is shown in Fig. 1; English units are used.  
Assume the beam is subject to a downward vertical force, Fy = 3800 lb applied by a 
cylindrical pin (not shown) through a hole near its upper end.  Beam material is 2014 
Aluminum alloy.  The bottom of the curved beam is considered “fixed.”  In this context, 
the actual fixed end-condition is analogous to that at the end of a cantilever beam where 
translations in the X, Y, Z directions and rotations about the X, Y, Z axes are considered 
to be zero.  However, recall 
from Chapter 1 that Fixture 
types within SolidWorks 
Simulation also depend on 
the type of element to which 
they are applied.  Therefore, 
because solid tetrahedral 
elements are used to model 
the curved beam, 
Immovable restraints are 
used. 
   
  

Figure 1 – Three dimensional model of a curved beam. 
(Dimensions in “inches”) 
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Design Insight 
Numerous mechanical elements occur in the shape of initially curved beams.  
Examples include: C-clamps, punch-press frames, crane hooks, and bicycle caliper 
brakes, to name a few.  This example examines stress at section A-A shown in Fig. 2.  
For cases, such as this, where applied load, F¸ acts to one side of the cross section 
under consideration, classical equations calculate bending moment M = F*L about the 
centroidal axis (not the neutral axis) at that location.  Reaction force R = F is also 
applied here.   Accordingly, classical equations for stress in a curved beam can be used 
to predict stress at section A-A.  In this example, the validity of this assumption is 
investigated while exploring additional capabilities of SolidWorks Simulation 
software.  
 

 
 

 
Figure 2 – Traditional free-body diagram of the upper portion of a curved beam model showing 
applied force F acting at a hole, and reactions R = F, and moment M acting on cut section A-A. 
 
 
Creating a Static Analysis (Study) 
 

1. Open SolidWorks by making the following selections.  (NOTE: The symbol “>” 
is used below to separate successive menu selections).   

 
Start>All Programs>SolidWorks 2014   (or)   Click the SolidWorks 2014 icon on your 
screen. 

 
2. In the SolidWorks main menu, select File > Open…  Then browse to the location 

where SolidWorks Simulation files are stored and select the file named “Curved 
Beam;” then click [Open]. 

R = F = 3800 lb 

A 

M = F*L = 3800*9 = 34200 in-lb

A 

F = 3800 lb 

L = 9 in
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Simulation      
tab 

 

Reminder: 
If you do not see Simulation listed in the main menu of the SolidWorks screen, click 
Tools > Add-Ins…, then in the Add-Ins window check  SolidWorks Simulation in 
both the Active Add-Ins and the Start Up columns, then click [OK].  This action 
permanently adds Simulation to the main menu every time a file is opened. 
 

 
Because one goal of this chapter is to introduce and to use Simulation icons during the 
solution process, set-up of the Simulation toolbar is described below.  If you previously 
set up the Simulation toolbar as outlined in the Introduction to this text, the Simulation 
tab should appear above the graphics area on your screen.  In that case, click on the 
Simulation tab and skip to step 5.   
 
 
Setting up the Simulation Toolbar 
 

If the Simulation tab, shown in Fig. 
3, does not appear at the top left of 
your screen, add it to the other tabs as 
follows.  Otherwise, skip to step 2. 

 
 
Figure 3 – Useful tabs located below the main  menu. 

 
 

1. Right-click on any of the tab names (Features, Sketch, Evaluate, etc.) and from 
the pull-down menu, click to place a check “” adjacent to  Simulation.  This 
action adds the Simulation tab beneath the main menu. 

 
2. Initially the Simulation tab and its associated toolbar, shown boxed in Fig. 4, 

contains either the Study  or Study Advisor  icon.  If other icons appear 
they will be “grayed out” until a Simulation Study is started. 

   

 

 
Figure 4 –Common icons found on the Simulation tab. 

 
Presuming the Simulation icons to be unfamiliar to new users, the icon display mode 
illustrated in Fig. 6, which includes descriptive captions, is used throughout the 
remainder of this chapter.   To display icons with captions, proceed as follows. 
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3. Right-click anywhere on any toolbar at the top 
of the screen to open the Command Manager 
menu shown in a partial view in Fig. 5. 
 

4. Just below Command Manager at top of this 

menu, click to select  Use Large Buttons 
with Text.  This action adds a brief description 
beneath each icon as shown in Fig. 6.  NOTE:  
Fig. 6 will not appear with active icons until a 
new study is initiated in step 8 below. 

 
 
 
 

Figure 5 – Command Manager 
pull-down menu. 

 

 
Figure 6 – View of the Simulation toolbar with descriptive captions applied beneath each icon. 
 

 
5. In the Simulation tab begin a new study by selecting the ▼symbol located on the 

Study Advisor  icon.  From the pull-down menu select  New Study.  The 
Study property manager opens (not shown). 

 
6.  In the Name dialogue box, replace Static 1 by typing Curved Beam Analysis - 

YOUR NAME.  Including your name along with the Study name ensures that it 
is displayed on each plot.  This helps to identify results sent to public access 
printers. 

7. In the Type dialogue box verify that  Static is selected as the analysis type. 
 
8. Click [OK]  (green check mark) to close the Study property manager.   

 
Notice that an outline of the new Study is now listed beneath the Simulation manager tree 
and icons on the Simulation tab become active as shown in Fig. 6. 
 
Now that an icon-based work environment is established, our Study of stress in the 
curved beam continues below.  As in the previous example, the sequence of steps 
outlined in the Simulation manager, at the left of your screen, is followed from top to 
bottom as the current Study is developed. 



Curved Beam Analysis 

2-5 

Assign Material Properties to the Model 
 

Part material is defined as outlined below. 
 

1. On the Simulation tab, click to select the Apply Material  icon.  The 
Material window opens as shown in Fig. 7.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Figure 7 – Material properties are selected and/or defined in the Material window. 
 
 
2. In the left column, select SolidWorks Materials (if not already selected).  

Because the left column typically defaults to Alloy Steel or displays the last 
material selected, click the minus “-” sign to close the Steel folder if necessary. 

 
3. Click the plus sign next to the + Aluminum Alloys and scroll down to select 2014 

Alloy.  The properties of 2014 Aluminum alloy are displayed in the right half of 
the window.  

 
4. In the right-half of this window, select the Properties tab (if not already selected), 

and change Units: to English (IPS) if necessary.   
 
In the table, note the material Yield Strength is a relatively low 13997.56 psi 
(essentially 14000 psi).  Material with a low yield strength is intentionally chosen to 
facilitate discussion of Factor of Safety later in this example.  Examine other values 
in the table to become familiar with data listed for each material. 
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Within the table, also notice that some material properties are indicated by red text, others 
by blue, and some by black.  Red text indicates material properties that must be specified 
because a stress analysis is being performed.  Conversely, material properties highlighted 
in blue text are optional values, while those listed in black primarily refer to thermal or 
vibration damping properties and, as such, are not needed for this stress analysis. 

 
5. Click [Apply] followed by [Close] to close the Material window.  A check mark 

“” appears on the Curved Beam folder to indicate a material has been selected.  
Also, the material type (-2014 Alloy-) is listed adjacent to the model name. 
 

6. If the “What would you like to do?” window opens, click anywhere to close it. 
 
 
 
 
 
 
 

 

 
 

Applying Fixtures 
 

For a static analysis, adequate restraints must be applied to stabilize the model.  In this 
example, the bottom surface of the model is considered “fixed.”   

 

1. On the Simulation tab, click ▼ beneath the 
Fixtures Advisor  icon, shown boxed in Fig. 8, 
and from the pull-down menu select Fixed 
Geometry.  The Fixture manager opens as shown 
in Fig. 9.   
 

2. Within the Standard (Fixed Geometry) dialogue 
box, select the  Fixed Geometry icon (if not 
already selected). 

Figure 8 – Selecting the 
Fixture icon. 
 

 

3. The Faces, Edges, Vertices for Fixture field is highlighted (light blue) to 
indicate it is active and waiting for the user to select part of the model to be 
restrained.  Rotate, and/or zoom to view the bottom of the model.  Next, move the 
cursor over the model and when the bottom surface is indicated, click to select it.  
The surface is highlighted and fixture symbols appear as shown in Fig. 10.  Also, 
Face<1> appears in the Faces, Edges, Vertices for Fixture field. 

Aside:  

If at any point you wish to change the material specification of a part, such as during 
a redesign, simply right-click the name of the particular part whose material properties 
are to be changed and from the pull-down menu select Apply/Edit Material…  The 
Material window opens and an alternative material can be selected.   
 

However, be aware that when a different material is specified after running a solution, 
it is necessary to run the solution again using the revised material properties. 
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If an incorrect entity (such as a vertex, edge, or the 
wrong surface) is selected, right-click the incorrect item 
in the highlighted field and from the pop-up menu 
select Delete; then repeat step 3. 

 
4. If restraint symbols do not appear, or if it is 

desired to alter their size or color, click the 
down arrow  to open the Symbol Settings 
dialogue box, at bottom of the Fixture property 
manager, and check the  Show preview box.  
 

5. Both color and size of the restraint symbols 
(vectors in the X, Y, Z directions) can be 
changed by altering values in the Symbol 
Settings dialogue box of Fig. 9.  Experiment by 
clicking the up ▲ or down ▼ arrows to change 
size of restraint symbols.  A box of this type, 
where values can be changed either by typing a 
new value or by clicking the ▲▼ arrows, is 
called a “spin box.”  Restraint symbols shown 
in Fig. 10 were arbitrarily increased in size to 
200%.   

 
 
 
 
Figure 9 – Fixture property 
manager. 

 
 

 
6. Click [OK]  (green check mark) at top of the 

Fixture property manager to accept this 

restraint.  An icon named  appears 
beneath the Fixtures folder in the Simulation 
manager tree.  
 

Figure 10 – Fixtures applied to 
bottom of the curved beam model. 

 



Analysis of Machine Elements Using SolidWorks Simulation 
 

2-8 

 
 
 
 
 
 
 
 
 
 

 
 
Applying External Load(s) 
 

Next apply the downward force, Fy = 3800 lb, at the hole located near the top left-hand 
side of the model shown in Figs. 1 and 2.  This force is assumed to be applied by a pin 
(not shown) that acts through the hole.   
 

 

Analysis Insight: 
Because the goal of this analysis is to focus on curved beam stresses at Section A-A, 
and because Section A-A is well removed from the point of load application, modeling 
of the applied force can be handled in a number of different ways.  For example, the 
downward force could be applied to the vertical surface located on the upper left side 
of the model, Fig. (a).  Alternatively, the force could be applied to the upper or lower 
edge of the model at the extreme left side, Fig. (b). These loading situations would 
require a slight reduction of the magnitude of force F to account for its additional 
distance from the left-side of the model to the centroidal axis at section A-A (i.e., the 
moment about section A-A must remain the same). 
 

        
 

 
 
 
 
 
 
Figure (a) – Force applied to left surface.            Figure (b) – Force applied to lower edge. 
 
The above loads are simple to apply.  However, the assumption of pin loading allows 
us to investigate use of a Split Line to isolate a portion of the bottom surface of the hole 
where contact with a pin is assumed to occur.  This surface is where a pin force would 
be transferred to the curved beam model.  The actual contact area depends on a number 
of factors, which include: (a) geometries of the contacting parts (i.e., relative diameters 
of the pin and hole), (b) material properties (i.e., hard versus soft contact surfaces of 
either the pin or the beam), and (c) magnitude of the force that presses the two surfaces 

 

Aside: 
Restraint symbols shown in Fig. 10 appear as simple arrows with a small disk added 
to its tail.  These symbols indicate Fixed restraints when applied to shell or beam 
elements.  Fixed restraints set both translational and rotational degrees of freedom to 
zero (i.e., both X, Y, Z displacements and rotations (moments) about the X, Y, Z axes 
are zero).  However, when applied to either solid models or truss elements, only 
displacements in the X, Y, and Z directions are restrained (i.e., prevented).  This latter 
type of restraint is referred to as Immovable.  The software applies appropriate 
fixtures based on element type.  Watch for this subtle difference in future examples. 
 

A A A A 
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together.  This example arbitrarily assumes a reasonable contact area so that use of a 
Split Line can be demonstrated.  If, on the other hand, contact stresses in the vicinity of 
the hole were of paramount importance, then determination of the true contact area 
requires inclusion of the actual pin and use of Contact/Gap analysis.  This type of 
analysis is investigated in Chapter #6. 
 

 
 
Inserting Split Lines 
The first task to simulate downward pin loading on the hole bottom is to isolate a small 
area at the bottom of the hole.  This can be accomplished by using a Split Line.  The 
method described below outlines use of a reference plane to insert a Split Line.  
 

1. In the drawing toolbar, at top center of the graphics 
area, reorient the model by clicking the Trimetric or 
Isometric view icon. 

 
 
 
2. From the main menu, select Insert.  Then, from succeeding pull-down menus 

make the following selections:  Reference Geometry ► followed by Plane…  In 
Fig. 11 the Plane property manager opens to the left of the graphics area.  Also, a 
SolidWorks “flyout” menu appears at the top left of the graphics area to provide 
access to SolidWorks options; see label in Fig. 11. 
 

 
Figure 11 – The Plane property manager and SolidWorks flyout menu. 
 

 
3. Within the Plane property manager, under First Reference, the field is 

highlighted (light blue) to indicate it is active and awaiting selection of a plane 
from which a new plane can be referenced. 

 

SolidWorks 
Flyout menu 
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Figure 12 (a) - The Plane property manager and selections           Fig. 12 (b) – Flyout menu 
to create a reference plane passing through the bottom of the hole.      (enlarged view). 

 
 
4. Begin by clicking the “+” sign to open the SolidWorks flyout menu circled in 

Figs. 12(a) and (b).  Within the flyout menu select the Top Plane, see arrows.  
The Plane property manager changes appearance as shown in Fig. 12(a) and Top 
Plane appears in the First Reference dialogue box.  For those using the Curved 
Beam part file from the textbook web site, the top plane passes through the part 
origin, which is located on the bottom of the model1 in Fig. 12 (a). 

 

5. Return to the First Reference dialogue box and in the Offset Distance spin-
box and type 14.75.  This is the distance from the Top Plane to a Reference 
Plane located so that it intersects the bottom portion of the hole in Fig. 12 (a). 

 

Aside: 
The 14.75-in. dimension is determined from the following calculation. Refer to Fig. 1 to 
determine the source of values used in the equation below. 
 

10 in (height of straight vertical sides) + 3 in (radius of concave surface) + 1.75 in 
(distance from the horizontal edge beneath the hole and extending an arbitrary distance 
into the bottom portion of the hole) = 14.75in. 

 

It is emphasized that the area intersected on the bottom of the hole is chosen arbitrarily 
in this example! 
 

                                                 
1 Users who created a curved beam model from scratch can also follow these instructions.  The only 
difference would be specification of the proper distance from the Top Plane (used as a reference in your 
model) to the bottom of the hole. 

Top Plane 

Reference Plane 

Offset 
Distance 
Spin Box 

Origin 
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Split Lines 

6. Click [OK]  to close the Plane property manager. 
 

The reference plane created in the previous steps appears highlighted on your screen. If 
your model is large enough it will be labeled Plane1, if not, zoom-in on the top of the 
model.  In the following steps Plane1 is used to create Split Lines near the bottom of the 
hole.  These Split Lines enable us to define a small “patch” of area on the bottom of the 
hole where the downward load will be applied. 

 
7. From the Main Menu, select Insert.  Then, from 

the pull-down menus choose: Curve ► followed 
by Split Line…  The Split Line property 
manager opens as shown in Fig. 13. 

 
8. Beneath Type of Split, select  Intersection.  

This choice designates the means by which Split 
Lines are defined for this example (i.e., Split 
Lines will be located where the reference plane 
intersects the hole). 
 

9. In the Selections dialogue box, Plane1 should 
already appear in the Splitting Bodies/Faces/ 
Planes field.  If Plane1 does not appear in this 
field, click to activate the field (light blue), then 
move the cursor onto the graphics screen and 
select the upper plane when it is highlighted.  
Plane1 now appears in the top field.  

Figure 13 – Split Line property 
manager showing selections. 

 
10. Next, click inside the Faces/Bodies to Split 

field.  This field may already be active (light 
blue).  Then move the cursor over the model 
and select anywhere on the inside surface of 
the hole.  It may be necessary to zoom in on 
the model to select this surface.  Once 
selected, Face<1> appears in the active field.  
Figure 14 shows a partial image of the model 
with Split Lines appearing where Plane1 
intersects the bottom portion of the hole. 

Figure 14 – Close-up view of hole 
showing Split Lines where Plane1 
intersects near the bottom of hole. 
 
 

Remain zoomed-in on the model to facilitate applying a force to the inside of the hole. 
 

11. In the Surface Split Options dialogue box, select  Natural.  A Natural split 
follows the contour of the selected surface. 



Analysis of Machine Elements Using SolidWorks Simulation 
 

2-12 

12. Click [OK]  to close the Split Line property manager. 
 

13. If an information “flag” appears adjacent to the Split Lines, click  to close it. 
 
 

Applying Force to an Area Bounded by Split Lines 
 

Now that a restricted area on the bottom of the hole has been identified, the next step is to 
apply a downward force, Fy = 3800 lb, on this area.  Proceed as follows. 

 

1. On the Simulation tab, click ▼beneath the External Loads…  icon and from 

the pop-up menu select the  Force icon.  The Force/Torque property manager 
opens and appears in a partial view in Fig. 15. 

 
2. Within the Force/Torque dialogue box, click 

the   Force icon (if not already selected).  
Also, click  Selected direction.  Then click 
to activate (light blue) the upper field titled 
Faces, Edges, Vertices, Reference Points for 
Force.  

 
3. Move the cursor over the model and when the 

bottom inside surface of the hole is outlined, 
click to select it.  Face<1> appears in the active 
field of the Force/Torque dialogue box. 

 
4. Next, click to activate the second field from the 

top of the Force/Torque dialogue box.  
Passing the cursor over this field identifies it as 
the Face, Edge, Plane for Direction field.  
This field is used to specify the direction of the 
force applied to the bottom of the hole. 

 
Because a downward, vertical force is to be applied, 
select a vertical edge . . . any vertical edge . . . on the 
model aligned with the Y-direction.  After selecting a 
vertical edge, Edge<1> appears in the active field and 
force vectors appear on the model as seen in Fig. 16.  

 

5. In the Units dialogue box, set Units  to 
English (IPS) (if not already selected). 

 
Figure 15 – Specifying a force and 
its direction on the hole bottom. 
 

6. In the Force dialogue box, type 3800.  As noted in an earlier example, it may be 
necessary to check  Reverse Direction if the force is not directed downward. 
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7. Click [OK]  to accept this force 
definition and close the Force/Torque 
property manager.  An icon named 
Force-1 (:Per item: 3800 lbf:) appears 
beneath the External Loads folder in 
the Simulation manager.  

Figure 16 – Downward force applied 
between Split Lines on bottom of hole.  
A wireframe view of the model is shown. 

 
The model is now complete as far as material, fixtures, and external load definitions are 
concerned.  The next step is to Mesh the model as described below. 
 

 
Meshing the Model 
 

1. Within the Simulation tab, select ▼ beneath the Run  icon.  From the pull-

down menu, select the  Create Mesh icon.  The Mesh property manager opens 
as shown in Figs 17 (a) and (b). 

 

2. Check  to open the  Mesh Parameters 
dialogue box and verify that a  Standard 

mesh is selected.  Also set the Unit  field to 
in (if not already selected).  Accept the 
remaining default settings (i.e., mesh Global 
Size and Tolerance) shown in this dialogue 
box.   

 

3. Click the down arrow  to open the Advanced 
dialogue box, Fig. 17 (b).  Verify that Jacobian 
points is set at 4 points (this setting indicates 
high quality tetrahedral elements are used).  
These default settings produce a good quality 
mesh.  However, verify that the settings are as 
listed and only change them if they differ.  

Figure 17 (a) – Mesh property 
manager showing system default 
Mesh settings applied to the 
current model. 
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4. Finally, click [OK]  to accept the default mesh 
settings and close the Mesh property manager. 
 

Meshing starts automatically and a Mesh Progress 
window appears briefly.  After meshing is complete, 
SolidWorks Simulation displays the meshed model shown 
in Fig. 18.  Also, a check mark “” appears on the Mesh 
icon to indicate meshing is complete.   

 

Figure 17 (b) – Views of the 
Advanced and Options 
portions of the Mesh property 
manager. 

  
5. Since Plane1 is no longer needed, hide the reference plane by right-clicking it 

and, from the pop-up menu, select the  Hide icon. 
 

OPTIONAL: 
 

6. Display mesh information by right-clicking the Mesh folder (not the Create Mesh 
icon) and select Details...   

 
The Mesh Details window displays a variety 
of mesh information.  Scroll down the list and 
note the number of nodes and elements for 
this model is 12578 nodes and 7229 elements 
(numbers may vary slightly due to the 
automated mesh generation procedure).  

 
Rotate the model as illustrated in Fig. 18 (a 
Trimetric view) and notice that the mesh is 
two elements thick.  Two elements across the 
model’s thinnest dimension are considered 
the minimum number for which Solid 
Elements should be used.  Thus, two elements 
are considered an unofficial dividing line 
between when Shell or Solid Elements should 
be used.  Therefore, either element type could 
be used for this model.  But, keep in mind 
that shell elements are typically reserved for 
thin parts. 
 

7. Click  to close the Mesh Details 
window. 

Figure 18 – Curved beam with mesh 
and boundary conditions illustrated.  
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Default 
Results 
folders 

Note that 
your name 
appears in 
the filename 

Reminder 

Recall that it is permissible to define material properties, fixtures, external loads, and 
create the mesh in any order.  However, all these necessary steps must be completed 
before running a solution. 

 
 

Solution 
 
After the model has been completely defined, the solution process is initiated.  During a 
solution the numerous equations defining a Study are solved and results of the analysis 
are automatically saved for review.  

1. On the Simulation tab, click the Run  icon to initiate the solution process. 
 
After a successful solution, a Results folder appears 
below the Simulation manager.  This folder should 
include three default plots saved at the conclusion of 
each Study.  These folders are named as illustrated in 
Fig. 19.  If these folders do not appear, follow steps (a) 
through (f) outlined on page 1-14 of Chapter #1. 
 
If Units displayed on the Stress1 (-vonMises-) and 
Displacement1 (-Res disp-) plots are not psi and in 
respectively, then change them as outlined in steps 2 
through 5.  Otherwise, skip to the next section. 
  

2. If the von Mises stress plot is not shown, 
double-click Stress1 (-von Mises-) to display 
the plot. 

 
3. Next, right-click Stress1 (-vonMises-) and 

from the pull-down menu select Edit 
Definition… The Stress Plot property 
manager opens.  In the Display dialogue box, 

verify Units  are set to psi.  If not, use the 
pull-down menu ▼ to change Units.  

Figure 19 – Results folders created 
during the Solution process. 

 

4. Click [OK]  to close the Stress Plot property manager. 
 

5. Repeat steps (2) through (4), however, in step (2), double-click Displacement1 (-

Res disp-) and in step (3) in the Display dialogue box alter the Units  field 
from mm to in.  NOTE: Res disp is short for “resultant displacement.” 
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Examination of Results 
 
Analysis of von Mises Stresses Within the Model 
 

Outcomes of the current analysis can be viewed by accessing plots stored in the Results 
folders listed in the previous section.  This step is where validity of results is verified by 
cross-checking Finite Element Analysis (FEA) results against results obtained using 
classical stress equations or by experiment.  Checking results is a necessary step in good 
engineering practice!  
 

1. In the Simulation manager tree, double-click the Stress1 (-vonMises-) folder (or) 
right-click it and from the pull-down menu, select Show.  A plot of the vonMises 
stress distribution throughout the model is displayed. 

 
Figure 20 reveals an image similar to what currently appears on the screen.  SolidWorks 
Simulation 2014 has a new feature that combines all Results display options into a single 
property manager.  Access to those display options is accessible via three tabs at top of 
the Stress Plot property manager. We will use those tabs in the following steps to convert 
your current screen image to that shown in Fig. 20. 
 

 

Figure 20 – Front view of the curved beam model showing von Mises stress after making 
changes outlined below.  Note arrows indicating Yield Strength on the stress scale at right. 

 
 

NOTE:  Stress contour plots are printed in black, white, and grey tones.  Therefore, 
light and dark color areas on your screen may appear different from images shown 
throughout this text. 

Region of 
maximum Stress 

Areas of minimum 
von Mises Stress 
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2. Right-click Stress1 (-vonMises-) and from the pull-
down menu select Chart Options…  The Stress Plot 
property manager opens, a portion of which is shown 
in Fig. 21.  Note that the Chart Options tab is 
selected. 

 
3. Within the Display Options dialogue box, click to 

place check marks “” to activate   Show min 
annotation and  Show max annotation.  This 
action labels minimum and maximum vonMises 
stress locations and magnitudes on the model.  Do 
not change other checked items. 

Figure 21 – Upper portion of 
Chart Options tab showing 
current selections. 

 

4. Next, select the Settings tab.  A partial view of 
this tab is illustrated in Fig. 22. 

 

5. In the Fringe Options dialogue box, from the 
pull-down menu select Discrete as the fringe type 
to be displayed. 

 
6. Next, in the Boundary Options dialogue box, 

select Model from the pull-down menu to 
superimpose a solid outline on the model. 

 
7. Click [OK]  to close the Stress Plot property 

manager.  If the above changes are not displayed, 
on the model, double-click Stress1 (-vonMises-). 

Figure 22 – Selections in the 
Stress Plot property manager. 

 

8. On the Simulation tab, repeatedly click the Deformed Result  icon to toggle 
between a deformed image of the model (default state) and an un-deformed 
image.  See images in Fig. 23 (a) and (b).  When done, leave the model in the un-
deformed state and rotate it to a front view.  

 

Figure 23 (a) – Deformed model image.            Figure 23 (b) - Un-deformed model image. 
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The following observations can be made about the figure currently on your screen. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Modern software makes conducting a finite element analysis and obtaining results 
deceptively easy.  As noted earlier, however, it is the validity of results and 
understanding how to interpret and evaluate them properly that is of primary importance.  
For these reasons, we pause to consider two questions that should be intriguing or, 
perhaps, even bothering you, the reader.   
 
First, why are all stress values positive in Fig. 20?  (“+” stress values typically indicate 
tension).  However, compressive stresses are known to exist along the concave surface 
for the given loading.  Second, why does the solution show stresses above the material 
yield strength when stresses that exceed the yield strength indicate yielding or failure?  
These, and many others, are the types of questions that should be raised continually by 
users of finite element software.  Attempts to address these questions are included below. 
 
To answer these questions, we briefly digress to investigate the definition of von Mises 
stress as a means to determine a Safety Factor predicted by the software. 

 
Von Mises Stress - 
The example of Chapter 1 avoided the issue about what the von Mises stress is or what it 
represents.  That example further assumed that some readers might not be familiar with 
von Mises stress.  For the sake of completeness and because von Mises stress typically is 
not introduced until later in a design of machine elements course, its basic definition is 
included below.  Although this SolidWorks Simulation user guide is not intended to 
develop the complete theory related to von Mises stress, the usefulness of this stress 
might be summed up by the following statement- 
 

The equation for von Mises stress “allows the most complicated stress situation to 
be represented by a single quantity.”2  In other words, for the most complex state 
of stress that one can imagine (e.g., a three-dimensional stress element subject to a 

                                                 
2 Budynas, R.G., Nisbett, J. K., Shigley’s Mechanical Engineering Design, 9th Ed., McGraw-Hill, 2010, 
p.224. 

OBSERVATIONS: 
 Areas of low stress (dark blue) occur at the top-left side of the model and also 

through the vertical center of the model.  This last region overlaps the neutral 
axis.  The minimum von Mises stress is approximately 18. psi.  Regions of 
high stress are indicated in red.  The maximum stress indicated is 24870.8 psi, 
which occurs along the concave surface. (values may vary slightly) 

                                    

 Material Yield Strength =13997.6 ≈ 14000 psi is also listed beneath the color-
coded von Mises stress legend.  A red arrow adjacent to the color chart 
indicates where the Yield Strength lies relative to all stresses within the 
model.  In this instance, it is clear that some stress in the model exceeds the 
material yield strength.  Yield Strength and Safety Factor are investigated later 
in this chapter. 
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combination of shear and normal stresses acting on every face as illustrated 
below), these stresses can be reduced to a single number.  That number is named 
the von Mises stress.  This number represents a stress magnitude, “which can be 
compared against the yield strength of a material”3 to determine whether or not 
failure by yielding is predicted.  As such, the von Mises stress is associated with 
one of the theories of failure for ductile materials; theories of failure are briefly 
discussed below.  The von Mises stress is always a positive, scalar number. 

 
The above statement answers the question about the positive  
nature of von Mises stress shown in Fig. 20 and on your screen. 
It also should provide some insight into why von Mises stress, 
which is a single number, can be used to determine whether or 
not a part is likely to fail by comparing it to the part yield 
strength (yield strength is also listed as a single value).  The 
method of comparison used is the Safety Factor, which is 
explored later in this chapter. 
 
Although the above definition indicates that von Mises stress is always a positive 
number, that superficial answer might continue to bother readers who intuitively 
recognize that compressive stresses result along the concave surface of the curved beam. 
 
More fundamentally the issue in question gets to the heart of any analysis.  That question 
is, “What stress should be examined when comparing finite element results with stress 
calculations based on the use of classical equations?”  The answer, of course, is that one 
must examine the appropriate stresses that correspond to the goals of an analysis.  For 
example, in Chapter 1 it was decided that normal stress in the Y-direction (σy) was the 
primary stress component that would provide favorable comparisons with stress 
calculated using classic equations.  The Verification of Results section below reveals the 
appropriate stress for the current example.  Before continuing, answer the question: 
“What is the appropriate stress?”  Then, check your answer below. 

 
 

Verification of Results 
 

In keeping with the philosophy that it is always necessary to verify the validity of Finite 
Element Analysis (FEA) results, a quick comparison of FEA results with those calculated 
using classical stress equations for a curved beam is included below. 
 
Results Predicted by Classical Stress Equations 
Although not all users may be familiar with the equations for stress in a curved beam, the 
analysis below should provide sufficient detail to enable reasonable understanding of this 
state of stress.  The first observation is a somewhat unique characteristic of curved 
beams, namely, for a symmetrical cross-section the beam neutral axis lies closer to the 
center of curvature than does its centroidal axis.  These axes can be observed in Fig. 24.  
By definition the centroidal axis, identified as rc, is located half-way between the inside 
and outside radii of curvature.  However, the neutral axis, identified by rn, lies closer to 
                                                 
3  Ibid 
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the inside (concave) surface.  Based on this observation, a free body diagram of the upper 
portion of the curved beam is shown in Fig. 24.  Included on this figure are important 
dimensions used in the following calculations.  Dimensions shown are defined below. 
 

w = width of beam cross-section = 4.00 in (see Fig. 1) or ro – ri = 7.00 – 3.00 = 4.00 in 
d = depth (thickness) of beam cross-section = 0.75 in (see Fig. 1) 
A = cross-sectional area of beam = w*d = (0.75 in)(4.00 in) = 3.00 in2 
ri = radius to inside (concave surface) = 3.00 in 
ro = radius to outside (convex surface) = ri + w = 3.00 + 4.00 in = 7.00 in 
rc = radius to centroid of beam = ri + w/2 = 3.00 + 4.00/2 = 5.00 in 
rn = radius to the neutral axis = w/ln(ro/ri) = 4.00/ln(7.00/3.00) = 4.72 in. [determined 
       by equation for a curved beam having a rectangular cross-section] 
ci = distance from the neutral axis to the inside surface = rn – ri = 4.72 – 3.00 = 1.72 in 
co = distance from the neutral axis to the outside surface = ro – rn = 7.00 – 4.72 = 2.28 in 
e = distance between the centroidal axis and neutral axis = rc – rn = 5.00- 4.72 = 0.28 in 

Figure 24 – Geometry associated with calculation of stress in a curved beam. 

 
The reaction force Fy and moment M acting on the cut section are necessary to maintain 
equilibrium of the upper portion of the curved beam.  Equations used to compute the 
combined bending and axial stresses that result from these reactions are included below.  
Each equation is of the general form, 

Curved beam stress = + bending stress + axial stress 

Where the “+” sign for bending stress depends on what side of the model is being 
investigated.  Bending stress, caused by moment M, is compressive on the concave 
surface of the curved beam.  Hence a minus “-” sign is assigned to the bending stress 

r0 = 7.00 in

rn =4.72 in 
ci = 1.72in

co = 2.28 in 

F = 3800 lb ri = 3.00 in 

L = 4.00 in 

M = (4.00 + 5.00)(3800) = 34200 in-lb

rc = 5.00 in Fy = 3800 lb 

 Centroidal Axis
 

      Neutral Axis
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term in equation [1].  However, on the convex side of the beam bending stress causes 
tension on the beam surface thereby accounting for a “+” sign associated with the first 
term in equation [2].  Reaction force Fy acts to produce a compressive stress on the cut 
section.  Therefore, a minus “-” sign is used with the axial stress component in both 
equations [1] and [2] below.  In what direction do both of these stresses act? 
 
Stress at the inside (concave) surface:  

            
2 2

(34200 in-lb)(1.72 in) 3800 lb
-24610 psi

(3.00 in )(0.28 in)(3.00 in) 3.00 in
yi

i
i

FMc

Aer A
 

             [1] 

 
Stress at the outside (convex) surface: 

             0 2 2

(34200 in-lb)(2.28 in) 3800 lb
= 11990 psi

(3.00 in )(0.28 in)(7.00 in) 3.00 in
yo

o

FMc

Aer A
          [2] 

 
 
Comparison with Finite Element Results 
In addition to serving as a quick check of results, this section reviews use of the Probe 
tool.  Both bending and axial stresses act normal to the cut surface in Fig. 24.  Therefore, 
it is logical that the finite element analysis stress acting in the Y-direction (σy) should be 
compared with values computed using equations [1] and [2] above.  You are encouraged 
to produce a plot of stress σy on your own.  However, abbreviated steps are outlined 
below if guidance is desired. 
 

1. In the Simulation tab, click ▼ on the Results Advisor  icon and from the pull-
down menu, select New Plot.  Then from the next pull-down menu select the    

 Stress icon.  The Stress Plot property manager opens. 
 
2. In the Display dialogue box, select SY: Y Normal Stress from the pull-down 

menu.  Also in the Display dialogue box, set the Units  field to display psi. 
  
3. Click to clear the check “” mark from  Deformed Shape. 
 
4. Next, within the Stress Plot property manager, select the Chart Options tab. 

 
5. In the Display dialogue box check “” to select  Show min annotation and 

also  Show max annotation.  This action labels both maximum and minimum 
stress values of the plot of SY: Y Normal Stress. 
 

6. Finally in the Stress Plot property manager, select the Settings tab.   
 
7. Within the Settings tab, change the Fringe Options pull-down menu to Discrete. 

 
8. Click [OK]  to close the Stress Plot property manager. 
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9. If a plot of SY: Y Normal Stress like that in Fig. 25 does not appear, right-click 
SY: Y Normal and from the pull-down menu, select Show.  

 
Figure 25 – Plot of SY: Y Normal Stress (σy) on the curved beam model. 

 
The following observations can be made about Fig. 25.  
 

OBSERVATIONS: 

 Tensile (i.e., positive “+”) stress is shown in lime green, yellow, orange, and 
red.  This stress occurs primarily along the right vertical side and convex region 
of the model.  Because this region is subject to tensile stress, positive “+” stress 
magnitudes are expected. 

 

 Compressive (i.e., negative “-”) stress is shown by some green, light blue, and 
dark blue located along the left vertical and concave region of the model.  Once 
again compressive stress should correspond with the user’s intuitive sense of 
stress in that region.  Although labeled Min, compressive stress is algebraically 
larger than tensile stress. 
 

 Low stress regions, corresponding to the neutral axis, or neutral plane, which 
runs near the vertical center of the model.  Notice the sign change from “+” to 
“-” in the light green color coded region of the stress chart.  Recall, zero stress 
occurs on the neutral axis or neutral plane. 

 

 Note that Yield Strength is only labeled on the vonMises stress plot.  It does 
not appear on the current plot.  Also, min and max stresses are labeled. 

 

The model is next prepared to examine stresses at section Ai-Ao shown in Fig. 26. 
 

10. Right-click Stress2 (-Y Normal-) and from the pull-down menu, select Settings. 
Within the Stress Plot property manager, set the Boundary Options to Mesh.  A 
mesh is displayed on the model. 

Sign change 
from “+” to “-“

Region of high 
compressive stress 

Region 
of high 
tensile 
stress
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11. Click [OK]  to close the Stress Plot property manager.   
 
12. Zoom in on the model to where the curved beam section is tangent to the straight, 

vertical section, shown as Ai and Ao in Fig. 26, where subscripts “i” and “o” refer 
to the inside and outside surfaces of the model respectively.   

 

Figure 26 – Use the Probe tool to determine stress magnitudes at locations on the concave 
and convex sides of the curved beam model. 
 
 

13. On the Simulation tab click the  icon and from the pull-down 

menu, select the  Probe tool icon.  The Probe Result property manager opens 
as shown on the left side of Fig. 26. 

 
14. In the Options dialogue box, select  At location (if not already selected). 
 
15. Move the cursor over the straight vertical edges on the left and right sides of the 

model.  Each edge is highlighted as the cursor passes over it.  Click to select two 
nodes, indicated by a small circle, (one on the left and one on the right) located at 
the top end of each line.  These nodes are located at the intersection between the 
straight vertical section and the beginning of the curved beam section.  Selected 
nodes correspond to Ai and Ao in Fig. 26.  If an incorrect node is selected, simply 
click  At location in the Options dialogue box to clear the current selection and 
repeat the procedure.  Do not close the Probe Result property manager at this 
time. 

 
The above action records the following data in the Results dialogue box: Node number, 
Value (psi) of the plotted stress (σy), and the X, Y, Z coordinates of the selected node.  
Also, a small information “flag” appears adjacent to each node on the model and repeats 
data listed in the Results table.  It may be necessary to click-and-drag column edges to 
view values in the Results table. 

Bi

Ai Ao 

Bo 
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A A

Table I contains a comparison of results found by using classical curved beam equations 
and the finite element analysis results at locations Ai and Ao.  Rounded values are used. 

 
Table I – Comparison of stress (σy) from classical and finite element methods at 
Section A-A. 

       Location         Manual 
Calculation (psi) 

      Probe Tool  
     Results (psi) 

Percent Difference    
           (%) 

        Point Ai          -24610         -21618            13.8% 
        Point Ao            11990           14182            15.4% 

 
Examine all values and the Percent Difference (%) column.   Although, differences of 
this magnitude occasionally do occur, as an engineer you should be disappointed and, in 
fact, quite concerned at the significant difference between these results given the validity 
of the curved beam equations.  However, when results differ by this magnitude it is 
always appropriate to investigate further to determine the cause for the disparity and not 
simply “write off” the differences as due to the fact that two alternative approaches are 
used.  Can you provide a valid reason why such large differences exist? 
 
Further thought should reveal that St. Venant’s principle is once again affecting the 
results.  In this instance, a traditional engineering approach would dictate using classical 
equations for a straight beam in the straight 
vertical segment of the model below Section A-A, 
see Fig. 1 (repeated), and curved beam equations 
in the portion of the model above Section A-A.  
Therefore, common sense suggests that there is a 
transition region between the straight and curved 
segments where neither set of classical equations 
is entirely adequate.  In fact, due to the finite size 
of elements in this region, it is logical to presume 
that the finite element analysis provides a more 
accurate solution than do classical equations in 
this transition region. 

 
Figure 1 (Repeated) – Basic geometry 
of the curved beam model. 
 

 
Given the above observations, we next proceed to sample stress magnitudes at Section 
Bi-Bo in Fig. 26.  This new section is located slightly above the transition region.  
Proceed as follows. 

 
16. Move the cursor over the curved edges of the model. Then, on the concave side 

click to select the first node above the previously selected node.   
 
17. Next, on the convex side of the model, select the second node above the 

previously selected node.  This procedure selects nodes Bi and Bo in Fig. 26. 
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Observe the two new stress magnitudes listed in the Results dialogue box and compare 
them to values listed in Table II.  Nodes Bi and Bo, thus selected, lie on a radial line that 
forms an approximate angle of 7.5o above the horizontal.  Stress values calculated using 
the classical equations are modified to account for a slight shift of the centroidal axis due 
to beam curvature and for the change in angle of the axial force.  Using these values, a 
comparison of classical and FEA results in Table II reveals that values differ by at most 
4.1%, which is a significant improvement over previous calculations.   
 

Table II – Comparison of stress (σy) for classical and finite element methods at 
Section Bi-Bo. (Rounded values are used) 

       Location         Manual 
Calculation (psi) 

      Probe Tool  
     Results (psi) 

Percent Difference    
           (%) 

        Point Bi          -24515         -23777            3.1% 
        Point Bo            11940          12454             4.1% 

 
18. Click [OK]  to close the Probe Result property manager. 

 
This concludes the verification of Finite Element results, but note that even better results 
are expected at locations further from the transition region. 
 
 

Assessing Safety Factor 
 

SolidWorks Simulation provides a convenient means to determine and view plots of 
Safety Factor distribution in the model.  To use this capability, proceed as follows. 
 

1. In the Simulation tab, click ▼on the Results Advisor icon and from the pull-
down menu, select New Plot.  Then, from a second pull-down menu, select 
Factor Of Safety.  The Factor of Safety property manager opens as shown in 
Fig. 27 and displays the first step of a three step procedure. 

 
2.   Read text in the yellow Message dialogue box 

and at bottom of the Step 1 of 3 dialogue box.  
These messages indicate that Safety Factor is 
based on the failure criterion noted in the 
Materials window.  That criterion was specified 
as Max von Mises Stress.  

 
3.   In the upper pull-down menu of the Step 1 of 3 

dialogue box, choose either All or Selected 
Bodies.  Because there is only one part to be 
analyzed the result is the same in either case.   

 
4. Next, in the Criterion field, click ▼ the pull-

down menu to reveal names of the four failure 
criteria available to determine the factor of safety. 

Figure 27 – Factor of Safety, 
Step #1 of safety factor check. 



Analysis of Machine Elements Using SolidWorks Simulation 
 

2-26 

A brief overview of the four failure criteria is provided below. 
 

 Max von Mises Stress – This failure criterion is used for ductile materials 
(aluminum, steel, brass, bronze, etc.).  It is considered the best predictor of 
actual failure in ductile materials and, as such, provides a good indication of 
the true safety factor.  This criterion is also referred to as the “Distortion 
Energy Theory.”  

 

 Max Shear Stress (Tresca) – This criterion also applies to ductile materials.  
However, it is a more conservative theory thereby resulting in lower predicted 
safety factors.  As a consequence of its conservative nature, parts designed 
using this criterion may be somewhat oversized. 

 

 Mohr-Coulomb Stress – This failure criterion is applied to the design and 
analysis of parts made of brittle material (cast iron, etc.) where the ultimate 
compressive strength exceeds the ultimate tensile strength (Suc > Sut). 

 

 Max Normal Stress – Also applicable for brittle materials, this failure 
criterion does not account for differences between tensile and compressive 
strengths.  This theory is also regarded as the least accurate of the methods 
available. 

 

 Other failure criteria apply for shell 
elements made of composite materials.  
These criteria are not described here.  

 
5. Because the curved beam is made of 

aluminum and because a good estimate of 
safety factor is desired, choose Max von 
Mises Stress from the pull-down menu. 

 
Upon making the above selection, the Factor of 
Safety property manager changes to that illustrated 
in Fig. 28.  Immediately below the Criterion field 
notice that the factor of safety check is currently 
defined as  

  1
Limit

vonMises




  

Figure 28 – The failure criterion is 
selected in Step 1 of 3 of the Factor 
of Safety dialogue box. 
 
 

In other words, the above equation is currently set to identify locations in the model 
where the ratio of von Mises stress to the “limiting” value of stress (i.e., the Yield 
Strength) is < 1.    
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Thus, the above criterion identifies locations where yielding of the model is not predicted 
because model Yield Strength, the denominator, is greater than the von Mises stress, the 
numerator.  As initially defined, the above ratio is the inverse of the traditional safety 
factor definition, where:  

 
Safety Factor = n = strength/stress 

 
To plot only critical regions of the part, i.e., regions where 
the Yield Strength is exceeded and the safety factor is < 1, 
proceed as follows – 
 

6. Advance to the second step by clicking the right 

facing arrow button  at the top of the Factor of 
Safety property manager.  The Step 2 of 3 
dialogue box appears as shown in Fig. 29.  It may 
be necessary to click and drag its bottom edge to 
expand the Factor of Safety dialogue box. 

 
7. In the top pull-down menu, select psi as the set of 

Units to be used (if not already selected).  
 

8. Under Set stress limit to, click to select  Yield 
strength (if not already selected). 

 
9. Do not change the Multiplication factor.  
 

Notice that the material, 2014 Alloy aluminum, and its 
Yield and Ultimate strengths appear near the bottom of 
this dialogue box.   

Figure 29 – Step 2 of 3 in the 
Factor of Safety process. 

 
 

Design Insight – Focus attention near the top of the Step 2 of 3 dialogue box. 
 

In the event that a brittle material is being analyzed using the Mohr-Coulomb or the 
Max Normal Stress failure criteria, it is appropriate to select the  Ultimate strength 
as the failure criterion since brittle materials do not exhibit a yield point. 
 

The  User defined option is provided for cases where a user specified material is not 
found in the Material Property table. 
 

 

10. Click the right facing arrow button  at top of this property manager to proceed 
to Step 3 of 3 in the Factor of Safety property manager shown in Fig. 30. 

 
Two options are available for displaying the factor of safety.  Brief descriptions of each 
are provided on the next page. 
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 Factor of safety distribution – Produces a plot of safety factor variation 
throughout the entire part. 

 

 Areas below factor of safety – A desired 
value for safety factor is entered in the field 
beneath this option.  The resulting display 
shows all areas of the model below the 
specified safety factor in the color red and 
areas with a safety factor greater than the 
specified value in blue.  This approach easily 
identifies areas that need to be improved 
during the design process.  

 
 
Figure 30 – Redefinition of 
Factor of Safety and values to 
be displayed on the new plot. 

 
11. Beneath Step 3 of 3, select Areas below factor of safety and type “1” in the 

Minimum factor of safety: field (if not already “1”). 
  

At the bottom of this dialog box the Safety result field informs the user that the minimum 
factor of safety is 0.562809 which indicates that the design is not safe in some regions of 
the model.  Recall that this value is based on a comparison between Yield Strength and 
the maximum von Mises stress.  (Values may vary slightly from those shown).  

 
Also note that the above value of safety factor is virtually identical to that computed by 
the reciprocal of the equation appearing in the first Factor of Safety window.  That is: 

 
Yield Strength 13997

0.56281
Max. von Mises Stress 24870

Limit

vonMises




  
  

 

 
 

12. Click [OK]  to close the Factor of Safety property manager.  A new plot folder, 
named, Factor of Safety1 (- Max von Mises Stress-), is listed beneath the 
Results folder.  Also, a plot showing regions of the model where the Safety 
Factor < 1.0 (red) and where the Safety Factor > 1.0 (blue) is displayed. 

 
13. Right-click Factor of Safety1 (-Max von Mises Stress-), and from the pull-down 

menu, select Chart Options…  The Minimum factor of safety property manager 
opens. 

 
14. In the Display Options dialogue box, check  Show min annotation and click 

[OK]  to close the Minimum factor of safety property manager. 
    
The preceding step labels the location of minimum Safety Factor on the curved beam as 
shown in Fig. 31.  As expected, this location corresponds to the location of maximum 
compressive stress previously illustrated in Figs. 20 and 25. 
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Red indicates region 
where FOS < 1 
(yield predicted). 

Key to interpret 
Factor of Safety 
plot. 

The figure now on your screen 
should correspond to Fig. 31.  
This figure shows regions where 
the factor of safety is less than 1 
(unsafe regions) in red.  Regions 
with a factor of safety greater 
than 1 (safe regions) are shown 
in blue.  Localized regions, along 
the right and left vertical edges 
and extending into the concave 
region, have a safety factor less 
than one.   
 
The line of text, circled near the 
top-left in Fig. 31, provides a 
“key” to interpret safe and unsafe 
regions on the model.  

 

Figure 31 – Curved beam model showing areas where 
FOS > 1 (safety predicted) and where FOS < 1 (yield 
predicted). 
 

 
15. Double-click Factor of Safety (-Max von Mises Stress-) and repeat steps 1 

through 12 above, but this time set the Areas below factor of safety to 2 instead 
of 1, in step 11.  How does the plot change?  
 

A designer can repeat the above procedure for any desired level of safety factor check.  
 
In summary, an important aspect of the von Mises stress is that it can be used to predict 
whether or not a part might fail based on a comparison of its stress magnitude to the 
value of yield strength.  This topic is aligned with the study of theories of failure found in 
most mechanics of materials and design of machine elements texts. 
 
 

 

 

Analysis Insight #1: 

Faced with the fact that the above part is predicted to fail by yielding, a designer 
would be challenged to redesign the part in any of several ways, depending upon 
design constraints.  For example, it might be possible to change part dimensions to 
reduce stress magnitudes in the part.  Alternatively, if part geometry cannot be 
changed due to size restrictions, a stronger material might be selected, or some 
combination of these or other possible remedies might be applied.  Because part 
redesign might be considered an open-ended problem, it is not pursued here. 
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Analysis Insight #2: 
Return briefly to the vonMises stress plot by double-clicking Stress1 (-vonMises-) 
beneath the Results folder. 
 
Refer to Fig. 32 or your screen and notice that 
the material yield strength (13997.6 psi) is 
displayed beneath the color coded stress scale.  
Also, an arrow appears adjacent to the stress 
scale at a magnitude corresponding to this 
yield strength.  Thus, all stresses above the 
arrow exceed the material yield strength.  
Given this observation it is logical to ask, 
“What is the meaning of stress values above 
the material yield strength?” 

Figure 32 – von Mises stress plot for  
the curved beam model. 

 

The answer to this question is quite straight forward.  Stress values greater than the 
yield strength are meaningless!  Why is this true? 
 

Recall that the stiffness approach, described in the Introduction, indicated a finite 
element solution starts by determining deflection ΔL of a part subject to applied loads.  
Then, based on deflection, strain is calculated as ε = ΔL/L.  And finally, from strain, 
stress is calculated from the relation σ = Eε.  In words, the last equation states that 
“stress is proportional to strain,” where the constant of proportionality E (i.e., the 
modulus of elasticity) is determined from the linear portion of the stress strain curve 
illustrated in Fig. 33. 
 

Because this solution is based on a linear 
analysis, stress values above the yield 
strength in Fig. 32 are assumed to lie along 
a linear extension of the stress-strain curve 
shown dashed in Fig. 33.  However, above 
the yield strength, the actual stress-strain 
curve follows the solid curved line where 
stress is no longer proportional to strain.  
Thus, stress values reported above the yield 
strength are meaningless. 

Figure 33 – Stress vs strain curve for a 
typical elastic material shown by the 
solid curve. 

 
Problems where stress exceeds the yield strength can be solved in the Professional 
version of SolidWorks Simulation where non-linear analysis capabilities are available 
to conduct post-yield analysis. 
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Alternate Stress Display Option 
 

Because some users might prefer more immediate feedback to identify areas where 
material yield strength is exceeded, this section outlines steps to quickly identify those 
regions in a part.  This option is only valid for von Mises stress plots.  Another restriction 
is that this display option only applies to individual parts.  It does not apply to assemblies 
because individual parts within an assembly might be made of different materials each 
with their own yield strength.  Change the display as follows. 
 

1. Beneath the Results folder, right-click Stress1 
(-vonMises-) and from the pull-down menu, 
select Chart Options.  The Stress Plot 
property manager opens.  The bottom portion 
of this property manager is shown in Fig. 34.  

 
2. At the bottom of this property manager, click  

to open the Color Options dialogue box.  
 
3. Place a  mark to select  Specify color for 

values above yield limit and accept the default 
gray color specified.  

Figure 34 – Customizing displays 
where stress exceeds yield 
strength on von Mises plots. 
 

 
4. Immediately shades of gray are displayed on regions of the model and in the color 

coded stress chart where von Mises stress exceeds the material yield strength.   
 

Figure 35 – Altered plot displays stresses greater than the yield 
strength in shades of grey. 

Regions where vonMises 
stress > yield strength



Analysis of Machine Elements Using SolidWorks Simulation 
 

2-32 

5. Because it is not desired to keep this display, click  to close the Stress Plot 
property manager.   

 
The plot produced using this technique appears in Fig. 35 where all stress magnitudes 
greater than the material yield strength are displayed in gray tones.  Although this plot 
does not provide insight into magnitude of the Safety Factor, or lack thereof, it does 
reinforce the concept that stress magnitudes above the yield strength are meaningless.  
The shades of gray are unimportant.   
 
 
Determining Reaction Forces 
 

It is always good engineering practice to verify that results obtained correlate well with 
the given information.  One simple way to confirm that results correlate with given 
information is to check whether or not reaction forces are consistent with external loads 
applied to the model.  This section examines how to determine reaction forces at the base 
of the curved beam model.  To accomplish this, proceed as follows.   
 

1. On the Simulation tab, click ▼on the Results 
Advisor icon and from the pull-down menu, 
select List Result Force.  The Result Force 
property manager opens as shown in Fig. 36. 

 
2. In the Options dialogue box, verify that 
Reaction Force is selected. 
 

3. In the Selection dialogue box, set Units  to 
English (IPS) (if not already selected).   

 
4. The Faces, Edges, or Vertices field is active 

(highlighted light blue) and awaiting selection of 
the entity on which the reaction force is to be 
determined.  Rotate the model so that its bottom 
(restrained) surface is visible and click to select it.  
Face<1> appears in the active field.  This is the 
only face where reactions occur.  

 
5. Click the [Update] button and the Reaction force 

(lbf) table at the bottom of the property manager 
is populated with data.  Also, X, Y, and Z reaction 
force components appear at the base of the model 
and force magnitudes are contained within an 
information “flag” on the model.  

 
Figure 36 – Data appearing in 
the Result Force property 
manager. 
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The Component column in this table lists names for the sum of reaction forces in the X, 
Y, and Z directions and the Resultant: reaction.  Reaction force magnitudes listed in the 
Selection column are identical to those in the Entire Model column.  This result is 
expected because the entire model is restrained at only this one location. 
 

Results interpretation is as follows: (due to mathematical round-off values may vary) 
 

     SumX:   0.089078   (essentially zero) no force is applied to model in the X-direction 
     SumY:        3800.5  (essentially 3800 lb) equal and opposite to the applied force 
     SumZ:      0.53842   (essentially zero) no force is applied to model in the Z-direction 
     Resultant:   3800.5  (essentially 3800 lb = the applied force) 

 

It should be noted that a moment reaction at the base of the curved beam is missing from 
the Reaction Force table.  Also open  the Reaction Moment (lbf.in) dialogue box, 
near the bottom of the property manager, and observe it contains no data entries (i.e., no 
moment reactions).  This outcome does not agree with the usual conventions for reactions 
applied to a free-body diagram used in a traditional 
engineering statics course and shown in Fig. 2 
(repeated at right).  However, lack of a moment is 
consistent with our understanding of Immovable 
restraints applied to three-dimensional tetrahedral 
elements.  Recall, Immovable restraints only restrict 
translations in the X, Y, and Z directions at each 
restrained node on these elements.  This observation 
accounts for the fact that there are only three force 
reactions and no moments in the Reaction Force and 
Reaction Moment tables of Fig. 36.   

Figure 2 – (Repeated) 
 
The reaction force results above are valid for the entire model.  However, in many 
instances a model is supported (i.e., restrained) at more than one location.  In those 
instances it is necessary to determine reaction forces at other locations on a model.  
Performing a reaction check is quite simple and can be viewed as an additional means to 
verify the validity of boundary conditions applied to a model. 
 
Although a surface was selected to examine reaction forces in the above example, it 
should be evident that other geometric features, such as edges or vertices can also be 
selected at other restrained locations on a model. 
 

6. Click [OK]  to close the Result Force property manager. 
 
 
Is it Significant That the Model is NOT in Equilibrium? 
 
To answer the above question some additional insight is necessary.  Begin by recalling 
Newton’s second law of motion, which states any unbalanced force acting on a body 
results in an acceleration of that body in the direction of the unbalanced force.  This 
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motion is referred as “rigid body motion” and it follows that such motion is not tolerated 
in a static finite element analysis.  Simply stated, rigid body motion refers to motion 
(displacement) of an entire model irrespective of whether or not the body deforms due to 
applied loads.   
 
For example, in the case of the curved beam model it is not critical that reaction forces 
are not equal to zero in all directions.  Although these results indicate that true 
equilibrium is not attained, because ∑Fx  ≠ 0, ∑Fy  ≠ 0, and ∑Fz ≠ 0, the model cannot 
move because its base is Fixed by immovable restraints applied in the X, Y, and Z 
directions.  In summary, if a model is supported by Fixed restraints in all possible 
directions, then the fact that mathematical round-off occurs is of no consequence to 
equilibrium.   
 
 
Soft Springs Can Be Applied Where Other Restraints are not 
Appropriate 
 
Occasionally cases occur where model integrity is compromised by 
adding extra restraints.  Consider for example the model shown in 
Fig. 37 at right, where the model is subject to “equal and opposite” 
forces applied to its top and bottom holes.  In this case it is 
assumed that the model cannot be supported by additional Fixed 
restraints without interfering with accurate modeling of actual 
forces acting on the model.  However, as we saw above, Reaction 
Forces resulting from a finite element analysis typically do not 
equal zero in the X, Y, and Z directions.  And, resulting unbalanced 
force(s) would result in the model being subject to rigid body 
motion.     

Figure 37 - Model 
subject to “equal” but 
opposite forces. 

 
 
Because model movement with rigid body motion is prohibited within the software, what 
actually happens is that the Solution fails to execute and a message warning that a 
“singular stiffness matrix” has occurred is displayed.  Although this message is fairly 
obtuse, it simply indicates that the model is insufficiently restrained and, therefore, 
cannot be solved as presently formulated. 
 
One way to deal with unbalanced forces is to apply Soft Springs to support the model.  
These “springs” serve to stabilize the model against any unbalanced forces; therefore the 
analysis can proceed.   Look for end-of-chapter problems where a model must be 
supported by Soft Springs to overcome unbalanced force reactions that otherwise would 
result in rigid body motion.  Exercise 3-3 and 5-4 offer guidance regarding how to apply 
Soft Springs in the event they are needed.  
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Logging Out of the Current Analysis 
 

This concludes an introduction to analysis of the curved beam model.  It is suggested that 
this file not be saved.  Proceed as follows. 

 

1. On the Main Menu, click File followed by 
choosing Close. 
 

2. The SolidWorks window opens in Fig. 38, and 
provides the options of either saving the current 
document or not.  Select [Don’t Save].  
       

Figure 38 – SolidWorks window 
prompts users to either save 
changes or not. 
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EXERCISES 
 
End of chapter exercises are intended to provide additional practice using principles 
introduced in the current chapter plus capabilities mastered in preceding chapters.  Most 
exercises include multiple parts.  In an academic setting, it is likely that parts of problems 
may be assigned or modified to suit specific course goals. 

╬ Designates problems that introduce new concepts.  Solution guidance is provided for these problems. 
 
EXERCISE 1 – Curved Beam Stresses in a “C”- Clamp  
C-clamps, like that illustrated below, must pass minimum strength requirements before 
they can be qualified for general purpose use.  Clamps are tested by applying equal and 
opposite loads acting on the two gripping faces.  Part of the federal test criteria requires 
that the movable (lower) jaw be extended a certain percentage of the distance of the fully-
open state to ensure that column failure of the screw is an integral part of the test.  
Presuming that the movable jaw of the clamp satisfies the prescribed test criterion, 
perform a finite element analysis of the C-clamp subject to the following guidelines.  
 
  Open file: C-Clamp 2-1  
  

 Material: Cast Carbon Steel (use S.I. units)  
 

 Mesh:  In the Mesh property manager, select Standard mesh. 
 

 Fixture:  Fixed applied to the upper gripping surface of the C-clamp. 
  

 External Load:  950 N applied downward normal to the lower gripping surface. 
 
 

Figure E2-1 – “C”-clamp frame and cross-section dimensions.  
Stress to be determined at Section A-A.  (All dimensions in mm.) 
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(FEA result - classical result)
% difference *100                       [1]

FEA result
 

Determine the following: 
 

a. Use classical equations to compute stress at the inside and outside surfaces of 
the C-clamp frame at section A-A.  Section A-A is located where the straight 
and curved sections are tangent.  Include a free body diagram of the lower 
portion of the clamp and use curved beam equations.  

 

b. Create a stress contour plot of von Mises stress in the frame of the C-Clamp.  
Include automatic labeling of maximum and minimum von Mises stress on 
this plot. 

 

c. Use the Probe feature to produce a graph of the most appropriate stress 
acting on section A-A.  In other words, because values from this plot are to be 
compared with manual calculations of part (a), it is necessary to choose the 
corresponding stress from those available within the finite element software.  
Include a descriptive title, axis labels, and your name on this graph.  When 
using the Probe feature, begin at the concave (left inside) surface and select 
nodes across the model continuing to the outside of the “T” cross-section.  
Use equation [1] to compare percent differences between classical and FEA 
determination of stresses at the inside and outside surfaces. 

 
 

 
 

d. Assuming the C-clamp is made of a ductile material, produce a plot showing 
regions where the safety factor < 2.0.  Also, if the safety factor is < 1.0 at any 
location within the C-clamp, produce a second plot to highlight any un-safe 
regions.  Manually label region(s), if any, where safety factor < 1.0. 

 
 
 
 

EXERCISE 2 – Curved Beam Stresses in Hacksaw Frame 
A common, metal-cutting “hacksaw” is shown in Fig. E2-2.  A solid model of the 
hacksaw is available as file: Hacksaw 2-2.  The model is simplified to include two 0.125 
inch diameter holes that pass through the lower left and lower right ends of the hacksaw 
“backbone” labeled in Fig. E2-2.  For analysis purposes, the inside surface of the left-
hand hole is to be considered Fixed (i.e. immovable).  Use split lines to create a small 
“patch” of area on the inside surface of the hole located at the right end of the backbone.  
On this surface apply a 50 lb force induced by a tensile load in the saw blade, which is 
ordinarily held in place between these two holes.  Assume the following. 
 

 Material: AISI 1020 Steel, Cold Rolled (use English units) 
 

 Mesh: In the Mesh property manager, select  Standard mesh; use the default 
mesh size. 
 

 Units:  English (IPS)  
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(FEA result - classical result)
% difference *100                       [1]

FEA result
 

 Fixture: Fixed applied to inside of left hole. 
 

  External Load: 50 lb applied parallel to the X-direction on the inner surface of 
the right-hand hole (split lines needed; placement of these lines is user defined). 

 
Figure E2-2 – Basic geometry of a hacksaw frame.  Stress is to be 
determined at Section Q-Q. 

 
Determine the following: 
 

a. Use classical curved beam equations to compute stress at the inside (concave) and 
outside (convex) surfaces of the hacksaw frame at section Q-Q.  Section Q-Q is 
located where the straight and curved sections are tangent.  Include a labeled free 
body diagram of the right-portion of the model. 
 

b. Include a zoomed-in image of the right-hand hole so that the 50 lb applied load 
can clearly be seen to act between user specified Split Lines within the hole. 

 

c. Create a stress contour plot of von Mises stress in the saw backbone.  Include 
automatic labeling of maximum and minimum von Mises stress on this plot. 

 

d. Use the Probe feature to produce a graph of the most appropriate stress across 
section Q-Q, beginning at the inside (concave) surface and continuing to the 
outside (convex) surface of the backbone cross-section.  Use the Stress Plot 
property manager to select the appropriate stress for this plot to enable 
comparison with manual calculations of part (a).  Include a descriptive title, axis 
labels, and your name on this graph.  Also, below the graph, cut-and-paste a copy 
of the Probe Results table showing values used in this comparison [see Appendix 
A for procedures to copy SolidWorks images into a Word® document].  Then use 
equation [1], repeated below, to compute the percent difference between classical 
and finite element solutions at the inside and outside surfaces of the saw backbone 
at section Q-Q. 

 
 

 

Hacksaw 
backbone 

5.261
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e. Based on von Mises stress, create a plot showing all regions of the model where 

Safety Factor < 4.0 and circle these regions on the plot.  Include a software 
applied label indicating the maximum and minimum values for Factor of Safety. 
 

f. Question:  If stresses at section Q-Q, calculated using both classical equations and 
the finite element solution, differ by more than 4%, state the reason for this 
difference and describe at least one method to reduce the percent difference 
calculation at this location. 
 
 

 
EXERCISE 3 – Stresses in a Curved Anchor Bracket 
The curved beam shown in Fig. E2-3 is subject to a horizontal load applied by means of a 
pin (not shown) that passes through a hole in its upper end.  A solid model of this part is 
available as file: Anchor Bracket 2-3.  The lower-left end of the part is attached to a 
rigid frame (also not shown).  Because three-dimensional tetrahedral elements are to be 
used to model this part, the restraint at this location should be considered Immovable.  
Use split lines to create a small “patch” of area on the inside surface of the 16 mm 
diameter hole.  Locate these split lines 24 mm from the right edge of the model.  On this 
inner surface of the hole apply a horizontal force of 8600 N acting in the positive X-
direction (to the right).  Assume the following. 
 

 Material: AISI 1010 Steel, hot rolled bar (use SI units) 
 

 Mesh:    In the Mesh property manager, select  Standard mesh; use the 
  default mesh size. 

 

 Fixture:  Apply a Fixed (immovable) restraint on the inclined surface. 
 

 External Load: 8600 N in the X-direction applied on the right, inside surface of  
     the 16 mm diameter hole between user defined Split Lines. 

 
Determine the following: 
 

a. Use classical equations to compute stress at the inside (concave) surface and the 
outside (convex) surface of the anchor bracket at section B-B.  Section B-B passes 
through the center of curvature of the curved beam and is considered to be a 
vertical line.  Include a labeled free body diagram of the portion of the anchor 
bracket to the right of section B-B (show magnitude and direction of all 
reactions). 

 

b. Include a zoomed-in image of the hole so that the force Fx = 8600 N can clearly 
be seen to act between user specified Split Lines. 

 

c. Create a stress contour plot of von Mises stress in the anchor bracket.  Include 
automatic labeling of maximum and minimum stress on this plot. 
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(FEA result - classical result)
% difference *100                       [1]

FEA result
 

 

Figure E2-3 Dimensioned view of the Anchor Bracket.  Stress is to be determined 
at Section B-B. 

 
d. Using von Mises stress, create a plot showing all regions of the model where 

Safety Factor < 1.5 (if any).  Indicate this region(s), if any, by circling their 
location(s) on the figure and labeling them as “FOS < 1.5”.  Include a software 
applied label indicating locations of maximum and minimum values of Safety 
Factor.  Even if region(s) where Safety Factor < 1.5 are found, tell whether or not 
the entire model can be classified as having no region(s) where safety factor < 1.0. 

 

e. Use the Probe feature to produce a graph of the most appropriate stress across 
the bracket at section B-B.  Begin at the inside (concave) surface and continue to 
the outside (convex) surface.  (See the “HINT” on next page for guidance when 
making this graph).  Use the Stress Plot property manager to select the 
appropriate stress for this plot to enable comparison with manual calculations of 
part (a) above.  Add a descriptive title, axis labels, and your name to this graph. 

 

Below the graph or on a separate page either: (a) cut-and-paste a copy of the 
Probe Results table that includes values used for this comparison [See Appendix 
A for procedures to copy images from SolidWorks Simulation into a Word® 

document], or (b) click the Save icon  located in the Report Options dialogue 
box, to create an Excel spreadsheet containing all values in the Probe Results 
table.  [See Appendix A, page A-12] 

 

After determining both classical and FEA results at section B-B, use equation [1] 
to compute the percent difference between classical and finite element solutions at 
the inside and outside surfaces of the bracket. 
 

 
 
 

Surface is attached to 
a rigid frame (fixed). 

B  

B  
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f. If results of part (e) differ by 4% or more, determine the source of error in either 
the classical solution or finite element solution and correct it.  If no error is found, 
state why results differ by this significant percent difference.  

 
 

HINT:  Because the Standard mesh generation scheme within SolidWorks Simulation 
creates an optimized mesh, it is probable that (a) a straight line of nodes may not exist 
across the model at section B-B (thus, choose the best straight line available), and (b) it is 
also unlikely that node points occur exactly on a vertical line through the center of 
curvature.  For these reasons, and to obtain the best estimate of stress on a vertical line 
through section B-B, proceed as follows. 
 

 Zoom in on a front view of the model, with a mesh displayed, at section B-B. 
 

 On the Simulation tab, select the Plot Tools icon and from the pull-down menu, 

click the Probe tool  icon.  This action opens the Probe Results property 
manager.  

 

 In the SolidWorks Feature manager, move the cursor over the Right Plane label.  
This action highlights an edge view of the Right Plane at the desired location, 
which will assist in locating nodes closest to a vertical line at Section B-B.  
Unfortunately, the line disappears when the cursor is moved, but it is very useful 
none the less. 

 

 Complete the graph using the Probe tool. 
 
 

 
╬ EXERCISE 4 – Stresses in a Curved Photoelastic Model 
(Special Topics Include: Custom material definition, and using a “Hinge” 
joint for Fixture) 
A curved beam model, made from a photoelastic material and subject to axial load F, is 
shown in Fig. E2-4.  Beams such as this might be used in an experimental stress analysis 
laboratory where photoelastic techniques are studied.  Photoelastic material has a unique 
optical property known as birefringence.  Thus, when a photoelastic model is subject to 
applied loads in a field of polarized light, the light passing through the model undergoes 
changes of wavelength that produce visible “fringes” within the model as shown. 

 

Figure E2-4 – “Fringes” appearing in a photoelastic model 
subject to a tensile load applied through pin joints (not 
shown).  A grid is superimposed on the model to facilitate 
locating specific stress magnitudes and directions. 

F F 
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These “fringes” are analogous to, but not equal to, stress contour plots produced upon 
completion of a finite element analysis.  In this exercise, stresses produced within the 
curved beam model are examined.  Dimensioned views of a typical photoelastic beam are 
shown in Fig. E2-5. 

 

Figure E2-5 – Top view (above) and front (edge) view of a curved beam model. 
(Dimensions: inches) 
 

 
Create a finite element model of this part that includes custom material specification, 
fixtures, external loads, mesh, solution, and results analysis. 
 
Open the file:  Curved Bracket 2-4 
 

 Material:  Material properties are not found in the SolidWorks material library 
     (use custom properties below) 

   E = 360e3 psi Modulus of Elasticity (use English units) 
       ν =  0.38  Poisson’s ratio 
   Sy = 2200 psi Yield Strength 
 

 Mesh:   In the Mesh property manager, select a  Standard mesh; use the 
 default mesh size.  (Although this model is very thin, use a solid mesh.) 

 

 Fixture: Hinge Joint applied at hole on left end of the model. 
 

 External Load: 72 lb in the X-direction applied between user defined split lines 
   on the inner surface of the hole located at the right end of the model. 
 

F F 

C 

C

A B
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Two aspects of this exercise are unique.  First, properties of the photoelastic material are 
not available in the SolidWorks material library.  And second, the fixture at the left hole 
of the curved bracket is considered to be a Fixed Hinge joint.  Guidance in the 
application of these two items is provided below. 

 
 

Solution Guidance 
It is assumed that the user has opened the model file and started a Study in SolidWorks 
Simulation.  The following instructions are to serve as a “guide;” they are less detailed 
than the step-by-step procedure found in example problems. 
 
Custom Material Specification   
The recommended way to create a custom material definition is to begin with a similar 
existing material and then edit material properties as outlined below. 

 
 Open the Material window by right-clicking the Curved Bracket 2-4 folder 

and selecting Apply/Edit Material… 
 

 Close all open pull-down menu(s) beneath SolidWorks Materials. 
 

 Because photoelastic material is a special, clear “plastic like” material, open the 
Custom Materials folder at the bottom of the SolidWorks Materials list. 

 

 Next click “+” to open the Plastic folder and beneath it select Custom Plastic.  
The right side of the window is populated with property values for an 
unspecified material. 

 

 On the Properties tab, select Units: as English (IPS). 
 

 Adjacent the Name: field, change the name “Custom Plastic” to “Photoelastic 
Material.”  The Description and Source: fields can be left blank. 

 

 Within the Property column of the lower table notice that red, blue, and black 
colors are used to indicate different Property names.  Red lettering indicates 
information required for a stress solution.  Blue lettering indicates desirable, but 
not necessary information.  And, property names appearing in black are not 
required for the current solution.  For each red item, enter the values listed 
beneath “Material” in the problem statement, but do not change the existing 
value in the Mass density field.  Do not alter other values listed in the table. 

 

 Click [Apply] followed by [Close] to exit the Material window.  A check “” 
appears on the Curved Bracket 2-4 part folder and the Name: assigned above 
appears on the part folder.  You have successfully defined a custom material. 

 
Fixed Hinge Specification   A Fixed Hinge joint acts like a door hinge.  This joint 
type allows rotation about a fixed axis on the model, but prevents translation along that 
axis.  A Fixed Hinge is used at the left end of Curved Bracket 2-4 to prevent 
translations in the X, Y, Z directions, but allows the model to rotate thereby 
maintaining alignment with the external load as the part deforms.  Proceed as follows. 
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Solution Guidance (continued) 
 

 Right-click the Fixtures folder and from the 
pull-down menu select Fixed Hinge…  The 
Fixture property manager opens as shown 
in Fig. E2-6. 

 
 In the Standard (Fixed Hinge) dialogue 

box, the Cylindrical Faces for Fixture 
field is highlighted (light blue).  

 
 Zoom in on the left hole of the model and 

select its inner surface.  Face<1> appears in 
the highlighted field, shown in Fig. E2-6.  
This cylindrical surface has an axis 
perpendicular to the model face.  

Figure E2-6 – Specifying a Fixed 
Hinge restraint. 

 

 Click [OK]  to close the Fixture property manager. 
 
A Fixed Hinge restraint allows the model to undergo rotations about the selected hole, 
but no translations perpendicular to the hole.  The remainder of this solution uses 
previously mastered procedures.   

 
Special Solution Note: 
Due to specification of a Fixed Hinge on this model, it is highly likely that the above 
warning message will appear during the Solution portion of this analysis. 
 
Click the [ No ] button if the above Linear Static window appears and continue with 
the “small displacement” Solution.  
 

 
 

Determine the following: 
 

a. Use classical equations to compute stress at the inside (concave) surface and the 
outside (convex) surface of the curved bracket model at section C-C.  Section 
C-C passes through the center of curvature and is considered to be a horizontal 
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(FEA result - classical result)
% difference *100                       [1]

FEA result
 

line in the top view of Fig. E2-5.  Include a free body diagram of the portion of 
the model to the right of section C-C; label all magnitudes and directions. 

 

b. Turn off the deformed image.  Then, include a zoomed-in image of the right 
hole so that the external load, Fx = 72 lb, can clearly be seen to act between user 
specified Split Lines on the inner surface of the hole. 

 

c. Create a stress contour plot showing the most appropriate stress that should be 
analyzed acting across section C-C.  The most appropriate stress should 
correspond to the stress calculated in part (a).  Do stress fringes on the FEA 
model loosely approximate those shown in the photograph in Fig. E2-4? 

 

d. Use the Probe feature to produce a graph of the most appropriate stress across 
section C-C, beginning at the inside (concave) surface and continuing to the 
outside (convex) surface of the model.  (See the “HINT” near the end of this 
problem for guidance when making this graph).  Use the Stress Plot property 
manager to select the appropriate stress for this plot to enable comparison with 
manual calculations of part (a) above.  Include a descriptive title, axis labels, 
and your name on this graph. 

 

Below the graph, or on a separate page, either: (a) cut-and-paste a copy of the 
Probe Results table that includes values used for this comparison [see 
Appendix A for procedures to copy SolidWorks Simulation images into a 

Word® document], or (b) click the Save  icon, located in the Report 
Options dialogue box, to create an Excel spreadsheet containing all values in 
the Probe Results table.  [See Appendix A, page A-12].  This spreadsheet can 
be inserted onto the page beneath the current graph.  In either table, circle the 
magnitudes of stress on the concave and convex surfaces at section C-C. 
 

After determining both classical and FEA results at section C-C, use equation 
[1] (repeated below) to compute the percent difference between these results at 
the concave and convex surfaces of the model. 

 

 
 
 

e. On the Probe graph created in part (d), label the distance of the neutral axis 
(neutral plane) from the concave edge of the model at section C-C.  Write a 
brief statement indicating how this value was determined.  Compare this value 
with the location of the neutral axis determined using classical equations? 

 

f. Return to the plot produced in part (c).  This time, use the Probe tool to sample 
stress magnitudes along the concave edge of the model beginning at point A and 
proceeding from node-to-node until reaching point B.  Include a graph of these 
results with your analysis.  Add a descriptive title, axis labels, and your name to 
this graph. 
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g. QUESTIONS:  Answer the following questions on a separate page. 
 

 Is the variation of stress through the middle of the model shown in the graph 
of part (d) expected?  Why?   
 

 Is the variation of stress shown on the graph of part (f) expected?  Why?   
 

 Is the location of the neutral axis determined in part (e) located where it is 
expected to occur on the curved bracket model?  Does the neutral axis of a 
curved member subject to axial load always occur at a location like that shown 
in the plot of part (e)?  Explain why or why not. 

 
h. Using von Mises stress, create a plot showing all regions of the model where 

Safety Factor < 1.4 (if any).  Indicate this/these region(s), if any, by circling 
its/their location(s) on the figure and labeling them as “FOS < 1.5”.  Include a 
software applied label indicating locations of maximum and minimum values of 
Safety Factor.  

 
 

HINT:  Because the mesh generation scheme within SolidWorks Simulation creates an 
optimized mesh, it is probable that (a) a straight line of nodes may not exist across the 
model at Section C-C, and (b) it is also unlikely that node points occur exactly on a 
horizontal centerline through the center of curvature.  For these reasons, and to obtain 
the best estimate of stress on a straight line through the center of the curved section, 
proceed as follows. 
 

a. Zoom in on a top view of the model at section C-C. 
 

b. On the Simulation tab, select the Plot Tools icon and from the pull-down menu, 

click the Probe tool  icon.  This action opens the Probe Results property 
manager.  

 

c. Open the SolidWorks flyout menu, located at top right of the graphics area, and 
move the cursor over the Right Plane label.  This action superimposes an edge 
view of the Right Plane onto the model.  This plane will assist in locating nodes 
closest to a straight line at Section C-C.  Unfortunately, the line disappears when 
the cursor is moved, but this action can be repeated and it is very useful. 
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╬ EXERCISE 5 – Curved Beam Stress in a Trailer Hitch 
(Special Topic Includes: Application of Remote Loads) 

The trailer hitch shown in Fig. E2-7 is subject to both vertical 
and horizontal force components when towing a trailer.  The 
vertical component, or “tongue weight” (W), is defined as 
the downward force due to trailer weight that acts on the 
hitch.  For safety reasons, tongue weight should lie between 
9% to 15% of the gross trailer weight (i.e. weight of the 
trailer plus its cargo).  Towing force (FT) is the force required 
to pull the trailer.  Tow force is zero when the trailer is at 
rest; is reasonably steady when pulling a trailer at constant 
speed; and is maximum during acceleration or deceleration. 

 
Figure E2-7 – Trailer hitch 
and ball assembly.                             

 
Open file:  Trailer Hitch 2-5.  The trailer hitch, minus the ball, appears in Fig. E2-8. The 
hitch is bolted to a rigid frame on the towing vehicle (not shown) at the two ½-in. holes.  
Because application of forces to the hitch “ball” may require abilities not yet introduced, 
and because stress in the ball are not the objective of this analysis, the problem can be 
simplified by defining applied forces using the Remote Load/Mass feature within 
SolidWorks Simulation.  Guidance in the application of a remote load is provided below.   
 
 

Figure E2-8 – Isolated view of the trailer hitch emphasizes its curved beam shape. 

A A 
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Assume the following. 
 

 Material: Alloy Steel (use English units, IPS) 
 

 Mesh:  In the Mesh property manager, select  Standard mesh and use 
the default mesh size. 

 

 Fixture:  To mimic bolt fasteners, apply a Fixed (immovable) restraint on 
the inside surface of the two, 1/2-in. bolt holes.  Bolted joints are 
considered in Chapter 7. 

 
 External Load:  Apply force components using the Remote Load/Mass feature 

described below. 
Tongue weight W = 200 lb (vertical downward). 

     Tow force FT= 550 lb (horizontal) in the +X-direction. 
 

Use of the Remote Load/Mass feature is described below.  This feature permits 
application of remote forces, moments, and displacements.  Remote masses are only used 
in cases of static, frequency, linear dynamic, or buckling studies.  Application of remote 
force is the only new topic introduced in this example.  However, once the principle is 
understood, users should be able to apply it to other listed features.  Remote Load/Mass 
is used primarily where modeling simplification can be realized.  For example, 
application of force components to curved surfaces of the hitch ball can be accomplished 
using several methods.  But, using the Remote Load/Mass option is one of the more 
direct approaches.  Also, its introduction allows this useful feature to be applied in other 
situations. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Solution Guidance 
 

It is assumed that the user has opened a Simulation file and started a Study.  The 
following instructions are to serve as a “guide;” they are less detailed than step-
by-step procedures found in example problems. 
 

Remote Load/Mass 
When used, the Remote Load/Mass feature, in effect, replaces a more complex 
portion of a model (or) part of the model that is not essential to the final analysis.  
Because this analysis focuses on stress in the curved portion of the hitch, the hitch 
“ball” can be replaced using a Remote Load/Mass.  When applying force 
components using this approach, proceed as follows. 
 

1. If a Global coordinate system triad is not visible at the bottom of the “ball” 
attachment hole, scroll to the bottom of the SolidWorks manager tree and 
click .  A “ghost” coordinate system triad is 
displayed at the bottom of the “ball” hole.  
 

2. In the Simulation manager tree right-click the  External Loads folder 
and select  Remote Load/Mass…  This example deals only with 
“load,” not “mass.” 
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Design Insight:   
The trailer hitch was intentionally designed with the Global coordinate system origin at 
the base of the ball hole.  This location was chosen because it permits easy application of 
a Remote Load/Mass on the model as outlined below.  Further, it is desired to apply 
forces W and FT at the center of the ball. 
 
Aided by the SolidWorks Sketch in Fig. E2-9, 
it is seen that the center of the “ball” is located 
1.616-in above the ball shoulder.  Also, the ball 
center is located above the Global coordinate 
system origin at X = 0, Y = 0.625 (hitch 
thickness) + 1.616-in, and Z = 0. Force 
components W and FT are defined in the 
following steps.  

 
 
 

Figure E2-9 – Determination of height 
above the hitch surface at which forces 
are applied to the “ball.” 

 

Solution Guidance (continued) 
 

3. In the Type dialogue box, select  Load/Mass (Rigid connection).  This 
option is used when stiffness of the part to be replaced is significant relative to 
the rest of the model (the hitch “ball” is considered very stiff).   Load/Mass 
(Rigid connection) is also selected because it can be applied to a Face, Edge, 
or Vertices of the part.  NOTE:  The  Load (Direct Transfer) option could 
also be used however it is less convenient in this case because it can only be 
applied to Faces (i.e., entire surfaces) of a model. 

 
4. Also in the Type dialogue box the Faces, Edges, or Vertices, for Remote 

Load/Mass field is active (highlighted light blue).  Move the cursor onto the 
edge of the “ball” hole on top of the hitch and click to select it.  Edge<1> 
appears in the active field.  This action establishes the top surface of the hitch 
as a reference location above which the hitch “ball” forces act. 
 

5. In the Reference Coordinate System dialogue box, choose  Global as the 
coordinate system origin from which some (not all) coordinates of the remote 
loads are defined.  For example, the preceding step defined the top surface of 
the hitch as the position above which the horizontal “ball” force is located. 
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Determine the following: 
 

a.   Use classical equations to compute stress at the inside (concave) surface and the 
outside (convex) surface of the trailer hitch model at section A-A.  Section A-A 
passes through the center of curvature and is considered to be a horizontal line 
in the front view of Fig. E2-8.  Include a labeled free body diagram of the 
portion of the model above section A-A.  Use definitions provided for a 
rectangular cross-section model shown above Fig. 24, p. 2-20 and equations [1] 
and [2] on p. 2-21, or use equations from your design of machine elements 
textbook.   Clearly label each calculation. 
 

b. Include an image of the hitch showing fixtures applied to lower two bolt holes 
and the Remote Load/Mass applied above the “ball” hole.  
 

Solution Guidance (continued) 
 

6. In the Location dialogue box, verify that Unit  is set to inches in.  Then, in 
the X-Location field, accept the zero (0) value shown.  In the Y-Location 
field, type 1.616, which is the distance above the hole edge selected on the top 
surface of the hitch.  Finally, in the Z-Location field, accept the default zero 
(0) value shown. 

7. If necessary, check  Force to open this dialogue box.  Verify that Unit  is 
set to lbf.  Then in the X-Direction field type 550.  In the Y-Direction field, 
type 200 and, if the Y-force vector is directed upward, check  Reverse 
Direction.  Finally, accept the Z-Direction default value of zero (0) since no 
force acts in the Z direction on the ball. 

 
8. Click  [OK] to close the Remote Loads/Mass property manager. 

 

 
 
Figure E2-10 – Specifying Location coordiniates and Force magnitudes in the Remote 
Loads/Mass property manager. 
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(FEA result - classical result)
% difference *100                       [1]

FEA result
 

c.   Create a stress contour plot showing the most appropriate stress that should be 
analyzed at section A-A.  The most appropriate stress should correspond to the 
stress calculated in part (a).   

 
d. Use the Probe feature to determine magnitudes of the most appropriate stress 

on both the concave and convex sides of the model at section A-A.  HINT – 
Display a mesh on the model.  Also, to avoid edge effects, sample stress 
magnitudes near the middle of the model.  To accurately locate the middle of 
the model, click the Front plane in the SolidWorks feature manager tree or in 
the SolidWorks flyout menu.  Then rotate the model to left and right side views. 

 
 

Cut-and-paste a copy of the model that includes Probe information flags 
showing stress magnitudes at the locations sampled.  See Appendix A for 
procedures to copy SolidWorks Simulation images into a Word® document. 
 

After determining both classical and FEA results at section A-A, use equation 
[1] (repeated below) to compute the percent difference between these results at 
the concave and convex surfaces of the model. 

 

 
 
 

 

e. QUESTIONS:  Answer the following questions on a separate page. 
 

 Are stress magnitudes near the middle (on front plane) of the concave and 
convex sides of the trailer hitch in good agreement with stresses calculated 
using classical curved beam equations?  (Include a definition stating what you 
consider to be “good agreement”). 

 

 Use the Probe tool to explore stress magnitude on section A-A, but at 
increasing distances from the model center.  Does stress magnitude vary as 
distance from the model center increases? If stress magnitude varies, does it 
increase, or decrease?  Is the variation of stress expected?  Why?   

 
f. Create a plot showing Safety Factor throughout the model.  On this plot 

include a software generated label showing the minimum Safety Factor and its 
location on the model.   

 
 
 

Textbook Problems 
It is highly recommended that the above exercises be supplemented by problems 
from a design of machine elements textbook.  A great way to discover errors made 
in formulating a finite element analysis is to work problems for which the solution 
is known by independent calculation or experiment.  Typical textbook problems, if 
well defined in advance, make an excellent source of solutions for comparison. 
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NOTES: 
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